
About ImageExplorer
PowerQuest’s ImageExplorer simplifies management of your image files. Working within a single screen, 
ImageExplorer gives you total control of the image files you can access. For example, you can view image file 
contents, copy image files, copy partitions within files, and restore individual program and data files from the 
image.
ImageExplorer also provides description capabilities, so you can easily identify individual image files and 
partitions.
For help on specific tasks, see the How Do I...? book in the Contents tab of this Help file.
{button ,JI(`',`Drive_Image_File_Editor_Window')} ImageExplorer Window 



ImageExplorer Window
All the features of ImageExplorer are accessed from the main program screen, pictured below, or by right-
clicking anywhere in the panes of the Locate or Recent window views. ImageExplorer also makes extensive use 
of drag and drop capabilities between panes. Click on any item in this image for a short explanation of the item. 
For help on specific tasks, see the How Do I...? book in the Contents tab of Help.

The Locate Pane
Click the Locate button (the default view) to display a hierarchical tree view of local disks and network drives 
that you can navigate. You can use this tree view to search for image files (.PQI) that you want to add to the 
Recent pane. From the Locate pane, you can right-click on a .PQI file to copy, delete, or verify an image or to 
view the image's properties. You can also right-click on a folder within the .PQI image to restore the entire folder 
and its contents. If you want to restore a single file, select a folder within the .PQI file in the Locate pane, right-
click a file in the Contents pane, then click Restore.



 



About Copy to Image
Use Copy to Image to copy single or multiple partitions to new or existing image files. Copied partitions will not 
overwrite any partition already in the file. Therefore, you can have several partitions with the same name or 
drive letter within one image file. You can copy partitions using the pull-down menu or drag and drop.

Drag and
drop task

Result

Drag and 
drop an 
entire .PQI
image 
from the 
Recent 
pane or 
the Locate
pane onto 
a drive or 
folder in 
the Locate
pane.

The Copy to 
Image dialog 
appears with 
the Destination
image text box
filled in 
according to 
the currently 
selected drive 
or folder in the 
Locate pane.

Drag and 
drop a 
partition 
within an 
image file 
onto 
another 
image file 
or onto a 
folder in 
the Locate
pane.

If the partition 
is copied to 
another image 
file, the Copy 
to Image 
dialog appears 
and the 
partition is 
added to the 
image file and 
inherits the 
characteristics 
of the target 
image file 
including 
compression 
ratio, 
password, and 
so forth.
If the partition 
is copied to a 
folder, the 
Copy to Image 
dialog is 
displayed and 
the partition is 
added to a 
newly-
created .PQI 
image.

{button ,JI(`',`To_copy_partitions_to_an_image_file')} To copy partitions to an image file 



To copy partitions to an image file
1 From the Locate or Recent pane, select the image file whose partitions you want to copy.
2 From the Partitions list box, select the partitions you want.
3 Click File  Copy to Image.

4 Specify the path to the target image file in the Destination image text box.
5 (Optional) Type a comment about the partitions in the Description text box.
6 Click a compression level. Compressing files can save disk space and time over a busy network.

Compre
ssion 
Option

Description

No 
Change

Keeps the same 
compression level.

None No compression is 
usually the fastest 
method for saving 
the image file and is 
useful if storage 
space is not an issue.
However, if you are 
saving your image 
file to a busy network
drive or to a 
relatively slow 
removable media 
device, compression 
may be faster than 
no compression since
there is less data to 
write to the file.

Low Low compression 
offers a 40% average 
compression ratio.

High High compression 
offers a 50% average 
compression ratio.

7 (Optional) Click Set Password, type a new password, then type it again in the Confirm password text box.
8 (Optional) Select Split image into segments, then specify the maximum byte size for the image file.

For example, if you want to save the file to CD, specify a file size of 670,000,000 bytes (670 MB) or less. When 
the file being saved reaches this size, ImageExplorer begins another file.

9 Click Copy.

Tip
· These steps are only for copying partitions to image files that were created in Drive Image 5.0.
· In step 7, be aware that ImageExplorer does not support the use of extended ASCII characters in passwords 

when you create a password-protected image; instead, you must use standard ASCII characters.



About Delete Image
Use Delete to remove an entire image file, including all partitions, folders, and files. If you delete an image file 
that resides on your local hard disk, it is sent to the Windows Recycle Bin. You cannot delete individual partitions 
or selected files or folders within an image file.
{button ,JI(`',`To_delete_an_image_file')} To delete an image file 



To delete an image file
1 From the Locate (Explore) or Recent pane, select the image file you want to delete.
2 Click File  Delete Image.

3 Click Yes to continue or No to cancel.

Tip
· You can also right-click on an image file, then click Delete Image from the quick menu.
· You can also delete image files using Windows Explorer.



About Verify Image
Use Verify Image to determine whether an image file is valid or corrupt. ImageExplorer will check to see that all 
of the files in the image are available for you to open, the internal data structures in the image file match the 
data that is available, and the image file can be uncompressed and create the expected amount of data.
This is useful if you have added partitions to an image and want to verify the integrity of the image.
{button ,JI(`',`To_check_the_integrity_of_image_files')} To check the integrity of an image file 



To check the integrity of image files
1 From the Locate (Explore) or Recent pane, select the image file you want to check.
2 Click File  Verify Image.

3 When the check is complete, click OK.

Tip
· You can also right-click on an image file, then click Verify Image from the quick menu.



About Restore
Use Restore to restore files or folders from a selected partition and save them to their original location or to any 
location you specify. You can restore single or multiple files and folders using the Restore option on the File pull-
down menu or you can use drag and drop.

Restoring Files from Spanned or Compressed Images
You can restore individual files or folders from spanned or compressed images without restoring the entire image
file.
If you restore an image that was created with an earlier version of ImageExplorer (before Drive Image 5.0), you 
can choose from the following image index options:

Image 
Index 
Option

Description

Continue Creates a 
temporary index.
This temporary 
index is 
generated as 
needed and 
shows all files 
and folders. 
When you select 
a folder, it may 
take a few 
minutes to 
decompress the 
image and 
expand the 
index. The 
temporary index 
may be fully 
expanded and 
saved upon 
exiting File 
Restore.

Create Generates the 
complete index 
and saves it for 
future use. 
Creating a 
complete index 
will take several 
minutes 
depending on 
the size of the 
image file. 
Specify a 
directory and 
filename, then 
click Save.

Browse Lets you select 
an index if one 
has already been
created and 



reassociate it 
with the image 
file. Image files 
end with the 
extension .PQI; 
image index files
end with the 
extension .PQX.

You must create either a temporary or full index to restore files or folders from spanned or compressed 
images. 

Working with Image Files from Previous Versions of Drive Image
If you restore files from an image that was created with an earlier version of ImageExplorer (before Drive Image 
5.0), you can do one of the following optional procedures to speed up the restoration process:
· Ensure that the index file (*.PQX) for the image is saved in the same directory where the image is saved. If 

ImageExplorer sees the index file in the same directory, it will treat older image files the same as image files 
created with Drive Image 5.0.

· If you do not have an index file for the image, you can use ImageExplorer to copy the image into a new image.
Then the image file is just like any other created with Drive Image 5.0.

{button ,JI(`',`To_restore_files_from_a_partition')} To restore files from a partition 



To restore files from a partition
1 From the Locate or Recent pane, double-click the image file that contains the partition with the files you want 

to restore.
2 (If applicable) Type the image file password, then click OK.
3 Double-click the desired partition.
4 Select the folder or files you want to restore.
5 Click File  Restore. (See Tips below.)

If you selected an image file that was created with an older version of Drive Image or ImageExplorer, a 
progress bar displays while the ImageExplorer expands the image index.

6 Click To this destination, then specify the location where you want to save the restored files. Click  to 
navigate to the location you want.

You can also click Restore to original path if you want to restore the folders or files to their original location.
If the original location does not include a drive letter (because the partition was hidden when you imaged it), 
you must enter a drive letter for the partition before you can restore it.

7 Click Restore to restore the files.
8 When file restoration is complete, click OK.
9 Click Close to return to the ImageExplorer main window.

Tips
· In place of step 4, you can use drag and drop to initiate a restore.

If you are in the Locate pane, drag the selected folders and files onto the target location within the same pane,
then continue with step 5.
If you are in the Recent pane, drag the selected folders and files to the Locate tab to automatically open the 
Locate pane. Continue dragging the selection onto the folder you want to have it automatically open. When 
you find the target location inside the folder, release the mouse button to drop the selection. Continue with 
step 5.

· In step 6, you can change the default destination path. For more information click See Also on the Help 
toolbar, then click About Options.

· In step 7, you can also click the Restore icon, or you can right-click on any file or folder in a partition, then click
Restore from the quick menu.



About Properties
Use Properties to display the property information (such as the partition name, its file system type, the size, and 
so forth) of a selected image file or a partition.
{button ,JI(`',`To_view_image_properties')} To view image properties
{button ,JI(`',`To_view_partition_properties')} To view partition properties 



To view image properties
1 From the Recent pane, select the desired image file.
2 Click File  Properties, or right-click the image file and click Properties.

The following table describes each option in the Image Properties dialog.
Option Specifies
Descripti
on

A user-assigned comment 
associated with the partition. If
the image was created with 
Drive Image 5.0 and is not 
marked read-only, you can edit
the description.

MS-DOS 
Name

A user-assigned name for the 
image.

Image 
size

The total size of the image.

Image 
date/tim
e

The date and time that the 
image file was created.

Spanned Whether the image file is 
spanned over several disks.

Compres
sion

Whether the selected partition 
is compressed or 
uncompressed.    The level of 
compression (Low or High) is 
also specified.
Low level compression yields 
an approximate 40% 
compression rate.    High level 
compression yields 
approximately 50%.

Passwor
d 
Protecte
d

Whether the selected partition 
is password protected.

3 Click OK to exit the dialog.



To view partition properties
1 From the Locate or Recent pane, double-click the image file that contains the desired partition.
2 Select the partition you want.
3 Click File  Properties, or right-click partition and click Properties.

The following table describes each option in the Partition Properties dialog.
Option Specifies
Display 
name

A user-assigned name for the 
partition.

Descripti
on

A user-assigned comment 
associated with the partition.

Drive 
letter

The partition drive letter.

Type The file system type (for 
example, FAT, NTFS, and HPFS)
used within the partition. 

Primary/
Logical

The selected partition's drive 
status as either Primary or 
Logical.

Partition
size

The total size of the partition. 
This total includes both used 
and free space.

Used 
space in
partition

The amount of used space 
within the partition.

Unused 
space in
partition

The amount of free or unused 
space within the partition.

Physical 
size in 
image

The actual size of the partition 
within the image file. This 
physical size may differ from 
the Partition Size depending 
upon the amount of used and 
free space within the partition 
and the compression level.

4 Click OK to exit the dialog.

Tip
· If the image file was created with Drive Image 5.0 and is not marked read-only or located on append-only 

media, you can edit the display name or the description of the partition in their respective text boxes.



About Exit
Use Exit to quit ImageExplorer. When you run ImageExplorer again, your previous view settings will be used.
{button ,JI(`',`To_exit_Drive_Image_File_Editor')} To exit ImageExplorer 



To exit ImageExplorer
    Click File 
 Exit.



About Copy and Paste
Use Copy with Paste to copy selected images, partitions, partition folders or partition files. Choose Copy and 
Paste from the Edit pull-down menu, or drag and drop items to quickly accomplish the same task.
Depending on what you copy, the paste feature will function slightly differently. Note that paste is only available 
if an item has been copied and the current selection is a valid paste target.

What are
you 
pasting?

Result

An image 
file

The Copy to 
Image dialog 
appears with 
the Destination
image text box
filled in with 
the currently 
selected folder 
or drive letter.

A partition
in an 
image file

The Copy to 
Image dialog 
appears and, 
after you click 
OK, the copied
partition is 
pasted to the 
target image. If
the target 
image is 
password-
protected, you 
must type the 
correct 
password 
before the 
partition can 
be added to 
the image.

Folders or 
files in a 
partition

The Restore 
dialog appears.
You can choose
to restore the 
copied folders 
or files to their 
original 
location or to a
folder path 
that you 
specify.

{button ,JI(`',`To_use_copy_and_paste')} To use copy and paste 



To use copy and paste
1 From the Locate or Recent pane, select the image files, partitions, or partition files and folders you want to 

copy.
2 Click Edit  Copy.

3 From the Locate or Recent pane, navigate to the folder where you want to paste the copied items.
4 Click Edit  Paste.
5 If you are copying a file or folder, the Restore dialog appears. Click the link at the bottom of this topic, and 
go to step 6 of that topic.

If you are copying an image or partition, verify the path you are pasting to (displayed in the Destination image 
text box.)

6 (Optional) Type a comment in the Description text box.
7 Click a compression level.

Compress
ion 
Option

Description

None No compression is 
usually the fastest 
method for saving 
the image file and is
useful if storage 
space is not an 
issue. However, if 
you are saving your
image file to a busy 
network drive or to 
a relatively slow 
removable media 
device, 
compression may 
be faster than no 
compression since 
less data is 
transferred over the
network.

Low Low compression 
offers a 40% 
average 
compression ratio.

High High compression 
offers a 50% 
average 
compression ratio.

8 (optional) Click Set Password, type a new password, then type it again in the Confirm password text box.
9 (optional) Select Split image into segments, then specify the maximum byte size for the image file.

For example, if you want to save the file to CD, specify a file size of 670,000,000 bytes (670 MB) or less. When 
the file being saved reaches this size, ImageExplorer begins another file.

10 Click Copy.

Tip
· In step 8, be aware that ImageExplorer does not support the use of extended ASCII characters in passwords 

when you create a password-protected image; instead, you must use standard ASCII characters.
To restore files from a partition 



About Select All
Use Select All to select (highlight) all items in the Contents pane. This is useful if you want to copy multiple 
partitions to a new image file or to restore multiple files and folders.
{button ,JI(`',`To_select_all_items')} To select all items 



To select all items
1 Click inside the Contents pane.
2 Click Edit  Select All.

Tips
· In step 2, you can also press <Ctrl+A> to select all items. Or, you can click the file at the top of the list box, 

scroll down to the bottom of the list box, hold down <Shift> and select the last file to select all items.
· To select a group of files that are next to each other, click the top file, then hold down <Shift> and click the 

last file in the list.
· To select a group of files that are not next to each other, hold down <Ctrl> while selecting the files you want.



About the View Menu
Use the View menu to display or hide various items on the ImageExplorer interface. To maximize the number of 
files and folders viewed in the ImageExplorer window, you can hide the toolbar or the text labels.
Displaying the toolbar provides you with quick access to commonly used features.
The Text Labels command displays or hides the text on each toolbar button.
The Status Bar displays or hides the description of toolbar buttons and pull-down menu items at the bottom of 
the ImageExplorer window.
You can also use the Refresh option on the View menu to re-scan and update the drive and folder views with any 
changes made outside of the ImageExplorer program.
{button ,JI(`',`To_display_or_hide_the_Toolbar_Text_Labels_or_Status_Bar')} To display or hide the Toolbar, Text 
Labels, or Status Bar 
{button ,JI(`',`To_refresh_the_screen')} To refresh the screen 



To display or hide the Toolbar, Text Labels, or Status Bar
    Click View 
 Toolbar or Text Labels or Status Bar.

When the menu option has a check mark next to it, the option is displayed.



To refresh the screen

    Click View 

 Refresh.

Tip
· You can also press <F5> to refresh the screen.



About Add Entry
Use Add Entry to add a previously created image file to the Recent Images pane for quick access. The Recent 
Images pane allows you to perform a variety tasks on the image such as viewing its contents or partition 
information.
Note that when you open an image from the Locate pane, it is automatically added to the Recent Images pane.
{button ,JI(`',`To_add_an_image_file_entry')} To add an image file entry 



To add an image file entry
1 Click Recent  Add Entry.

2 Navigate to the folder where the image file is located.
3 Select the desired image file.
4 Click Open.

Tips
· You can also click the Add Entry button on the toolbar.
· You can also right-click in the Recent Images or Contents pane, then click Add Entry from the quick menu.
· ImageExplorer can only add image files created with Drive Image or ImageExplorer.



About Remove Entry
Use Remove Entry to delete a single image filename from the list in the Recent Images pane. The image file itself
is not deleted. 
If you press <Delete> on a selected image file (or you use the Delete Image option), you will delete the listing in 
the Recent pane and the image file itself.
{button ,JI(`',`To_remove_an_image_file_entry')} To remove an image file entry 



To remove an image file entry
1 From the Recent pane, select the image file listing you want to remove.
2 Click Recent  Remove Entry.

3 Click OK.

Tips
· You can also right-click on an image file inside the Recent Images pane, then click Remove Entry from the 

quick menu.



About Clear Recent Images List
Use Clear Recent Images List to remove the list of all image files in the Recent Images pane. This option does not
delete any image files.
{button ,JI(`',`To_clear_Recent_Images_list')} To clear Recent Images list 



To clear Recent Images list

    From the Recent pane, click Recent 

 Clear Recent Images List.

Tips
· You can also right-click inside the Recent Images pane, then click Clear Recent Images List from the quick 

menu.



About Options
Use the General property page in Options to specify the default restore path. This path is used if you do not 
initiate an image restoration using drag and drop or copy and paste. 
When you use the Copy to Image option, you can specify the maximum byte size to use before an image is split 
into multiple files. For example, if you want to save the file to CD, you could specify a file size of 670,000,000 
bytes (670 MB) or less. When the file being saved reaches this size, ImageExplorer begins another file.
When you create an image file using Drive Image, you can specify the file extension you want; you do not have 
to use the default .PQI file extension. However, to view those files in the ImageExplorer, you must add the 
custom file extensions to the list box on the Image Extensions property page. All image files that match the 
extensions you have added to the list are displayed in the Locate and Recent panes.
{button ,JI(`',`To_change_General_options')} To change General options 
{button ,JI(`',`To_add_image_file_extensions')} To add image file extensions 



To change General options
1 Click Tools  Options 

 General.
2 (Optional) Specify the full path to the default restore location.
3 (Optional) Specify the maximum byte size for an image file.

For example, if you want to save the file to CD, you could specify a file size of 670,000,000 bytes (670 MB) or 
less. When the file being saved reaches this size, ImageExplorer begins another file.

4 Click OK.



To add image file extensions
1 Click Tools  Options 

 Image Extensions.
2 Type the image file extension in the Extension text box.

You do not need to type the period. It will be added automatically.
3 Click Add.
4 Repeat steps 2 and 3 to add more file extensions or, if you are finished, click OK.

Tips
· File extensions can be up to three characters long and can contain alphanumeric characters.
· To remove an extension, select it from the list box, then click Remove. To erase all extensions you have 

added, click Clear. *.PQI cannot be removed from the list.



About the Help Menu
When you are in ImageExplorer you can get help by accessing Contents from the Help pull-down menu. You can 
look up keywords in the Help Index or Find text in Help topics.
The following additional resources contain information on installing, configuring, and using ImageExplorer.
You can also click Help  Technical Support 

 Support Web site to access information about PowerQuest products on the PowerQuest web site, including 
technical white papers, frequently asked questions, support information, and news about product updates.



PowerQuest Technical Support
Before contacting PowerQuest, please try to resolve problems you encounter by using the online Help, the quick 
start guide, the README file, and PowerQuest's corporate web site.
Tips

· Your problem may be resolved by applying the most recent patch or upgrade of the software. You can 
download patches and upgrades from http://www.powerquest.com/updates.

· Your product serial number is required to obtain technical support.
· If you received a demo or trial version of the product, you are not entitled to complimentary technical 

support.
Term of Technical Support
Technical support is available to all registered users throughout the life of the product, which began when 
PowerQuest released the software to manufacturing and ends six months after the release of the next version of 
the software or when PowerQuest discontinues its development.
All PowerQuest technical support offerings are available for review at http://www.powerquest.com/support.
Corporate Web Site
The PowerQuest technical support web site, http://www.powerquest.com/support (available in English only), 
includes an overview of support options, an e-mail support request form, a list of error messages and information
to resolve problems you encounter, and answers to frequently asked questions about the product.
E-mail
To obtain e-mail technical support for specific technical questions, you can fill out the form at the web site 
specified below.

Language Location of E-mail Support Form
English http://www.powerquest.com/support/emsupport.cfm
French http://www.powerquest.com/support/emsupport.cfm?

language=FR
German http://www.powerquest.com/support/emsupport.cfm?

language=DE

Fax
Location Number
USA (801) 437-4218
Europe +31 (0) 20 581 9270

Fax a description of your problem to the technical support fax number. This service is available in the U.S.A., 
Canada, and Europe 24 hours, seven days. PowerQuest technicians try to respond to all fax requests within 24 
hours.

Telephone
Language Location Number
English U.K. +44 (0) 20 7341 5517
English U.S.A.1 (801) 226-6834 (toll number)
French France +33 (0) 1 69 32 49 30
German Germany +49 (0) 69 66 568 516

The U.S.A. call center is open Monday through Friday from 8:00 a.m. to 5:00 p.m., MST/MDT. Our European call 
center, located in the Netherlands, is open Monday through Friday from 9:00 to 18:00, CET.



About Split
Use Split to save an existing image file across a series of removable media disks (for example, floppy disks, Jaz, 
or Zip disks). You can use ImageExplorer to split image files after they have been created. You can also save split
image files to a network drive and later transfer the files to removable media, such as a CD-ROM.
You split an image by copying the whole image or selected partitions to a new image file and then splitting the 
new image file.
When you split an image file, you are automatically prompted for new media when media in a removable device 
is full.
{button ,JI(`',`To_copy_partitions_to_an_image_file')} To copy partitions to an image file 
{button ,JI(`',`To_use_copy_and_paste')} To use copy and paste 



About Combining Split Images
Use Combine to convert a split image file into a single, unified image file. Combine could be useful if you have an
image file stored on removable media, but you want to save it on a network directory or your hard disk.
If you select an image that is part of a spanned set (split image) and select Copy to Image, ImageExplorer 
combines the split images in the Destination image file.
{button ,JI(`',`To_copy_partitions_to_an_image_file')} To copy partitions to an image file 
{button ,JI(`',`To_use_copy_and_paste')} To use copy and paste 



About Password Protection
You can use ImageExplorer to copy an image to a new image with a new password. When you assign a password 
to an image, the password is encrypted into the file. Be aware, however, that ImageExplorer does not support 
the use of extended ASCII characters in passwords when you create a password-protected image; instead, you 
must use standard ASCII characters.
You add a password to an image by copying the whole image or selected partitions to a new image file and then 
specifying a password for the new image file.
You cannot copy, resave, restore, or download a password-protected image until you enter the correct password.
Partitions that already have a password cannot have the password removed using the No password protection 
option or cannot have a new password set using the Set password option without correctly entering the original 
password when prompted during the copy. Note that passwords are case-sensitive.
{button ,JI(`',`To_copy_partitions_to_an_image_file')} To copy partitions to an image file 
{button ,JI(`',`To_use_copy_and_paste')} To use copy and paste 



Toolbar
The toolbar gives you quick access to commonly used features. You can display or hide the text labels that are 
shown at the bottom of each button.
To maximize the number of files and folders viewed in the ImageExplorer window, you can hide the toolbar or the
text labels.
Click the Refresh button on the toolbar to re-scan and update the drive and folder views with any changes made 
outside of the ImageExplorer program.



Status bar
The Status Bar displays or hides the description of toolbar buttons and pull-down menu items at the bottom of 
the ImageExplorer window.



Contents pane
The Contents pane displays the contents of the selected drive, folder, image file, or partition.
When the Recent pane is displayed, you can do the following in the Contents pane:
· Copy partitions to an image file
· Delete a selected image file
· Verify that the selected image file is valid
· View the properties of a select image file
· Add or remove image files from the Recent pane, or clear the entire list.



Recent pane
The Recent pane (shown here with the "Recent" button selected) shows a hierarchical tree view of image files 
(.PQI) that you have added to this pane.
From this pane you can:
· Copy partitions to an image file
· Delete a selected image file
· Verify that the selected image file is valid
· View the properties of a select image file
· Add or remove image files from the Recent pane, or clear the entire list.



Documentation Survey
We value your feedback regarding the Drive Image user guide and the online Help. Please take a few minutes to 
complete this questionnaire. (To print this topic, click Options on the Help toolbar, then click Print Topic.) When
you have completed the questionnaire, please fax it to 801-705-4514. Thank you!
PowerQuest product and version:

Questions
1 How would you rate the quality of the documentation? (1=Poor - 5=Excellent)

Accuracy 1      2      3      4      5
Completeness1      2      3      4      5
Ease of use 1      2      3      4      5

2 How can we improve the documentation?

3 How often do you use the documentation?

4 What do you use the most to get answers? What do you use least?
· User guide-printed · Technical support
· User guide-PDF · Online Help
· Readme · Another user
· Web site (knowledge base)

5 What do you use to find what you are looking for in the documentation?
User Guide Online Help
· Table of Contents · Table of Contents
· Index · Index
· Find (PDFs only) · Search
· Quick Reference Guide (where applicable) · Other
· Other

6 What do you prefer to read first when you upgrade and want to learn about what is new in the program?
· Readme
· Quick Reference guide (where applicable)
· User guide (printed or PDF)
· Online Help
· Product box
· Web site
· Other



Locate pane
Use the Locate pane to display a hierarchical tree view of local disks and network drives. You can use the Locate 
pane, among other things, to search for image files (.PQI) that you want to add to the Recent pane.
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